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725-1 Weight Scale

Overview

Introduction The optional Weight Scale is used to ensure exactness and consistency in the 
amount of material deposited. The system software performs the adjustments (by 
manipulating the line width) as required to meet a Target Weight (operator 
interface is not required). 

Weight scales already installed in the system should be calibrated every six 
months or when a new scale is installed.

This option contains procedures to support the Xyflex and XyflexPro systems. 
Most information is common to both systems, when the procedures differ they 
will be identified.

Attention
Only those individuals assigned privileges are allowed to perform or change 
system calibrations and offsets. Refer to Chapter titled - System Administration 
and Security.

Attention
When performing any calibration procedure in this section, the command word 
“Select” refers to clicking the left trackball button.

Attention
Replacement and calibration of the weight scales should only be performed by a 
Speedline Field Service Engineer or a technician trained by Speedline.
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Overview
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Weighing Process

Description The weighing process is described as follows:

The Z-axis moves over to a previously taught position (the opening of the sliding 
cover). The dispense unit will dispense material into this opening onto the dispos-
able purge cup. The amount of material dispensed is taken from the program 
(command line) of the process program grid. The dispensed material is weighed 
by the weight scale. The weighed material is matched against the Target Weight 
in the template. If necessary, the system will adjust (through software) the dis-
pense unit output to keep within the targeted weight.

When the program is run (from the process program Grid) and the BEGIN WEIGH 
is encountered the weigh scale template is read. The software will read the 
templates information to determine whether to perform a weigh (depending on 
times or minutes between weighs established in the template).

If a weigh is performed the head moves over the purge cup and dispenses a small 
amount of material (establishes a bead of material on the needle) to simulate an 
actual dispense. The small amount of material deposited into the purge cup tares 
the weight scale (resets the scale back to zero).

Attention
The weight scale requires a minimum of 100 mg of dispensed material to activate 
the scale. When the system performs the scaled down version of the process 
program selected, several passes of this process program may occur. This is a 
normal condition of the system.

The dispense unit dispenses a scaled down version of the process program 
selected in the process program grid (dots are not scaled down, when selected). 
The dispense unit may perform this process several times (this is normal) in order 
to meet the system minimum dispense weight of 100 mg. 

The dispense unit dispenses the program (the scaled down version) until the 
weight of the sample falls within the tolerance of the Target Weight. The 
software achieves this desired weight by manipulating the line width (there is no 
operator interface required).

An optional predispense command maybe performed after converging. This 
command would be performed onto the predispense plates. The primary purpose 
is to eliminate any excess material from the needle tip.
725-1 Weight Scale, Benchmark 4.1 & 4.2 3
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Scale Location and Components
Scale Location and Components

Assembly Location The Weight Scale is located in front of the front conveyor rail, and is mounted as 
an assembly with the Needle Calibrator and the Pre-dispense Station. See Figure 
1.

Components Each dispense station consists of the following components, see Figure 1:

1. Scale (not visible, below weigh dish)
2. Disposable Weigh Dish and Pedestal
3. Sliding Cover

Figure 1

The sliding cover is made of a Pyrex ® type material. This cover may be removed 
for cleaning and should be handled with care.

The sliding cover serves two purposes:

a. The sliding cover is used to prevent any drafts or other air currents
from disturbing the pan and measurements.

b. The cover must be kept in the closed position when the machine is
in use to maintain the taught position of the hole location).

Needle Calibrator

Disposable Weigh Dish
and Pedestal

Sliding Cover

Pre-dispense Station
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Static Protection
Static Protection

Introduction Certain weight scale components may develop a static charge if left untreated. 
This static charge can develop at the sliding glass cover and/or at the plastic 
weigh dish. To prevent a static charge which in turn will deliver inaccurate 
readings at the scale the plastic weigh dish and sliding cover must be treated. 

This procedure should be performed daily or when a new weigh dish is placed on 
the scale when prompted by the Benchmark software.

Procedure The weight scale support kit includes a box of Staticide wipes which are used to 
treat the plastic weigh dish and sliding glass cover.

Treat the plastic weigh dish and sliding glass cover as follows:

1. Remove the sliding glass cover from the dash board.
2. Wipe a new plastic weigh dish with the supplied Staticide wipes. Wipe the 

entire top and bottom surface of the weigh dish.
3. Place treated weigh dish on weight scale pedestal.
4. Wipe the sliding glass cover with supplied Staticide wipes. Wipe the entire 

top and bottom surface of the cover.
5. Place treated sliding cover onto the dash board. Close sliding glass cover over 

the weight scale.
6. Xyflex models- Perform step one through step five at each dispensing location 

that contains a weight scale.
725-1 Weight Scale, Benchmark 4.1 & 4.2 5
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Teaching the Position of the Weight Scale
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .Initial Setup

Teaching the Position of the Weight Scale

Introduction The Weight Scale cover has a hole cut through it which allows the dispense unit 
to dispense onto the scale. The location of this hole must be taught in the X-, Y-, 
and Z- axis. The taught position settings are normally required only on initial setup 
or whenever the weight scale assembly is moved.

Procedure Teach the hole position of each Weight Scale as follows:

Attention
The weight scale coordinates for the disposable purge cup must be taught at all 
four heads (Xyflex only).

1. Select Calibrate>Weight Scale Position from the menu on the Machine 
screen. The first screen for teaching Weight Scale position appears. See Fig-
ure 2.

Figure 2

2. Read the on screen notes and select the Next> button.
Selecting the Cancel button aborts the process.

When the Next> button is selected, a second screen to select a Head appears. 
See Figure 3.
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Teaching the Position of the Weight Scale
Figure 3

3. From the list, select a Head to teach the weight scale position.
4. Select the Next> button and a screen with Trackball and TrackballZ buttons 

appears. See Figure 4.
Selecting the Cancel button aborts the process.

Figure 4
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Teaching the Position of the Weight Scale
Attention
Prior to teaching any coordinates for the Weight Scale, be sure the sliding glass 
cover is in the closed position.

5. Select the Trackball button. Be sure the sliding glass cover is in the closed 
position. Using the trackball, move the dispense unit over the center of the 
hole in the sliding glass cover. Position the needle tip over the center of the 
hole. See Figure 5.

Figure 5

6. Select the left button on the trackball, when the dispense units needle tip is in 
the desired location.

7. Select the Trackball Z button. Using the trackball, lower the needle of the dis-
pense unit through the hole in the sliding glass cover. Lower the needle into 
the hole until the needle is below the top surface of the sliding glass. See Fig-
ure 6.
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Teaching the Position of the Weight Scale
Figure 6

8. Select left button on trackball, when the dispense units needle tip is at the 
desired depth.

9. Select the Next> button after the desired settings for the Weight Scale are 
reached. Figure 7 appears.

Figure 7
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Teaching the Position of the Weight Scale
10. Select the Save button to accept the new calibration coordinates.
If the Cancel button is selected the process aborts.

11. Repeat step 1 through step 10 for each remaining head (Xyflex only).
This completes the Setup for the Weight Scale Location and you are returned to 
the Machine screen.
10 725-1 Weight Scale, Benchmark 4.1 & 4.2
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Template Description

Introduction XyflexPro templates allow the convenience of storing and recalling dispense 
parameters used for dispense routines.

Included in the template software is the use of an optional Weight Scale, which is 
used to accurately ensure exactness and consistency in the amount of material 
deposited.

There are several application-based template styles:

• Dot 
• Line
• Move
• Unfilled Rectangle
• Filled Rectangle
• Pre-Dispense Dot
• Pre-Dispense Line
• Array
• Weigh

All templates store a unique set of dispensing parameters, however:

• Filled and Unfilled Rectangle templates additionally store specific X and Y 
coordinates.

• Predispense Dot and Pre-Dispense Line templates store information related to 
the execution of the predispense.

• Array templates are used to create a process program of multiple dots within 
a defined space.

Apply a template to a specific command line by double clicking the left trackball 
while the pointer is in the Name field, and selecting a template from the list that 
appears. All parameters that are associated with that template are applied 
automatically.
Templates can be created during the programming process, or as a standalone 
function.
Refer to Chapter titled - Creating and Managing Process Programs for detailed 
description on Templates.
725-1 Weight Scale, Benchmark 4.1 & 4.2 11
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Template Description
Creating the Weigh 
Template

If a process requires precise weighing and control of the dispense material the 
Weight Scale is used. The weight scale is programmed using the weight scale 
template. 

To create a new weigh template: 

1. Select File>Templates.
A list of previously created templates appears. See Figure 8.

Figure 8

2. Select Weigh Template, from the drop down Filter list, to assign a template 
type.

3. Select the file listed in the Name field.
4. Type a new file name of your choice over the existing file name.

The New button becomes enabled.

5. Select the New button.
The view area changes to a comment box. See Figure 9.
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Template Description
Figure 9

6. Enter any relative information about this new file (Part Number, Board Size, 
Material, etc.) in the space provided.

7. Select the Next button.
The Weigh Template appears. See Figure 10.

Figure 10

Weigh Template
725-1 Weight Scale, Benchmark 4.1 & 4.2 13
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Template Description
Template Fields The weight scale parameters for Dot and Line templates both use the same 
software, the fields from Figure 10 are described as follows:

Target Weight - This is the ideal weight to achieve and maintain for a particular 
process program. This weight is determined by performing a sample test 
(dispense and weigh) on your particular process coupon (user defined).

Tolerance - The amount of deviation that the target weight can fall within and still 
be able to “Converge”. This tolerance can be established when performing the 
sample test on your particular process coupon (user defined).

Converge - This is when the dispense material (placed at the weight scale) 
meets the set goal (which includes the target weight and tolerance + or -). 

Calculate... - A pop-up calculator appears which is used to determine a Target 
Weight. See Figure 11.

Figure 11

Calculator fields are described as follows:

1. Select the Calculate button (see Figure 10), if the value in the Calculated 
Weight field is acceptable, select the OK button.
If Cancel is selected, no updates will occur to the Calculated Weight.

Weigh per head every - This number establishes when and how many times a 
template should be weighed.

Field Description

Length Length of a particular process program entity.

Height Height of a particular process program entity.

Width Width of a particular process program entity.

Density Density of the material that is being dispensed.

Calculated 
Width

Calculated weight from the values entered in the above fields.  
This number automatically calculates when values are placed in 
fields for Length, Height, Width, or Density.
14 725-1 Weight Scale, Benchmark 4.1 & 4.2
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Template Description
Times example: If a number 3 is entered, the sample will be weighed before 
dispensing the third line or dot. 

A value of zero indicates that the user wants to ignore the number of times 
encountered and default to the timer (time factor in Minutes).

Minutes - This number specifies the number of minutes that should elapse 
between weighing a template.

A value of zero indicates that the user wants to ignore the timer encountered 
(time factor in Minutes) and default to the number of times (Times).

The Times and Minutes are synchronized with each other. Whichever occurs first 
triggers a weigh.

PreDispense Template - An optional predispense command may be executed after 
a successful converge. This ensures that there is no residual material on the 
needle prior to dispensing on the actual product. The predispense command will 
dispense onto the predispense plate.

2. If all values within the Weigh Template fields are acceptable, select the Fin-
ish button.

Selecting the Cancel button aborts the process.
725-1 Weight Scale, Benchmark 4.1 & 4.2 15
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The Weight Scale Template and the Process Program Grid
The Weight Scale Template and the Process Program Grid

Introduction Each template type is designed to impact specific fields in the process program 
grid. The displayed template on any line controls how that particular line 
command will be dispensed.

Procedure To insert a weight scale template into the Process Program Grid:

1. With a process program loaded, select View>Process Program to display the 
Process Program Grid. The scrollbar at the bottom of the Process Program 
Grid is used to navigate to a desired column. See Figure 12.

2. Using the trackball, select the command lines where you want to apply the 
weight scale template (normally a string of dots or lines). This example has 
command lines 5 and 6 selected. The two lines selected will be subjected to 
the weigh process.

Figure 12

3. Select the Weight Selected Commands icon  from the toolbar. A 
Begin Weigh and an End Weigh command will automatically appear before 
and after the selected lines to be weighed.

4. Select the Save button.
16 725-1 Weight Scale, Benchmark 4.1 & 4.2
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The Weight Scale Template and the Process Program Grid
Viewing Weight Scale 
Data 

The weight scale Data may be viewed as the process is running.

To display the weight scale Data, select View>Data from the menu bar. See 
Figure 13.

Figure 13

This information view may be toggled On and Off depending on operator 
preference by selecting the View>Data from the menu bar.

The Weight Scale Information view shows the following fields per head.

Name - Name of the template that was just weighed.

Target Weight - Weight specified in the weight template as specified by the user.

% Tolerance - Percent difference the dispensed material can drift from the 
specified target weight and still be within spec.

Actual Weight - Weight of the last sample on the weight scale.

% Difference - The actual percent difference the dispensed material is from the 
specified target weight.
725-1 Weight Scale, Benchmark 4.1 & 4.2 17
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Alarm Conditions
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Alarm Conditions

Introduction There are several conditions created by the day to day operation of the 
system that require operator intervention. These conditions trigger one of 
several system alarms. In most cases the alarm will cause the yellow or 
blue light tree indicator to illuminate. In addition, an Alarm Status screen 
appears with a message indicating the nature of the error. Most alarm 
conditions require operator intervention.

Troubleshooting 
Weight Scale Alarms 

The following table is provided as a reference to assist in determining alarm 
causes and possible remedies related to the weight scale.

Alarm Condition Description Possible Remedy

Weight scale 
communications 
error

Weight scale is not talking to the 
computer / Com port.

Check weight scale 
data cable 
connections. Check 
the Inside Out 
Network Utilities 
configuration.

Weight scale 
error

The weight scale failed to zero. Check connections to 
the scale.
Check that the 
dispense cup has not 
overflowed into the 
scale.

Weight scale 
head not okay

Identifies the head where the weight 
scale failed.

Check all 
communications.

Weight scale 
dispense error

No material was dispensed into the 
cup.

Check or purge DU.

Weight scale no 
pre-dispense 
template

A predispense template was defined 
within the weight scale template. 
This template was later deleted prior 
to running the weight scale template.

Identify a different 
predispense template 
or create a 
predispense template 
with the same name 
in the weight scale 
template.

Weight scale 
global tolerance 
exceeded

The dispense weight has exceeded 
the tolerance set in the template.

Change weight scale 
purge cup and zero 
out scale.
18 725-1 Weight Scale, Benchmark 4.1 & 4.2
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Alarm Conditions
Refer to Chapter titled - Alarms and Troubleshooting for detailed description on 
dealing with system Alarms.

Alarm Condition Description Possible Remedy

Weight scale 
uninitialized 
request

Attempting to use a weight scale 
that has not been initialized.

Check comport 
connections and 
initialize machine.

No Weigh 
Template 
selected

BEGIN_WEIGH command is missing a 
template selection.

Select a template or 
delete the 
BEGIN_WEIGH 
command.

Missing matching 
END_WEIGH 
command

BEGIN_WEIGH command without a 
matching END_WEIGH command.

Place an END_WEIGH 
command in the 
patter.

Nested Weigh 
Blocks

Missing dispensing command 
between BEGIN_WEIGH and 
END_WEIGH commands.

Insert a dispensing 
command between 
the BEGIN_WEIGH 
and END_WEIGH 
command.
725-1 Weight Scale, Benchmark 4.1 & 4.2 19
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Maintenance Overview
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Maintenance Overview

Introduction

Attention
Replacement and calibration of the weight scales should only be performed by a 
Speedline Field Service Engineer or a technician trained by Speedline.

Attention
The Xyflex or XyflexPro System must be powered up for a minimum of 30 
minutes prior to calibration.

If a new Weight Scale is being installed into the system it must have the 
proper software parameters setup prior to calibration. This is only required 
during the initial installation.

The new Weight Scale must be calibrated after the initial software 
parameters are installed. 

Weight scales already installed in the Xyflex or XyflexPro system should 
be calibrated every six months.
20 725-1 Weight Scale, Benchmark 4.1 & 4.2
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Initial Setup of a Newly Installed Scale
Initial Setup of a Newly Installed Scale

Special Tools The initial setup process requires the following:

•  Calibration and Setup disk (Sartorious software, 
part of Calibration Kit)

•  50 gram mass (weight) and protective glove (part of Calibration Kit)

•  DB9 cable (part of Calibration Kit, Xyflex only)

Setup of 
Communication 
Cables (Xyflex only)

1. Open the front drop down door.

2. Slide the computer draw out.

3. Connect the supplied DB9 serial cable (part of Calibration Kit) to Com 
2 at the rear of the computer. See Figure 14.

Figure 14

4. Locate the USB serial hub on the right-hand side panel. See Figure 15. 
Remove the (applicable) cable of the newly installed weight scale from 
the hub. Connect the cable to the DB9 serial cable. This setup shows 
the connection for Head 4. 

DSB9 cable to 
Com 2 port
725-1 Weight Scale, Benchmark 4.1 & 4.2 21
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Initial Setup of a Newly Installed Scale
Figure 15

Software Installation

Attention
The Sartorius program file will not work with Windows NT® Operating 
System, the supplied bootable floppy (part of Calibration Kit) must be 
used.

1. Insert the calibration and setup disk (part of Calibration Kit) into the 
computer. Close NT and Restart the computer. The Sartorious screen 
appears. See Figure 16.

Head 1

Head 2

Head 3

Head 4 from serial hub

USB serial hub

DB9 cable from
Com 2 port
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Initial Setup of a Newly Installed Scale
Figure 16

2. Using the keyboard, press F2 to connect to the weight scale.

A delay of approximately 10 seconds will occur to complete 
communication to the weight scale. Do not press F2 more than once. 
Figure 17 appears.

Figure 17

3. Using the keyboard, press and hold the Alt key and the letter M 
(Alt + M). 

A drop down menu appears. See Figure 18.
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Initial Setup of a Newly Installed Scale
Figure 18

4. At the drop down menu, use the keyboard down arrow, and scroll 
down the menu until Read from file is highlighted. Press the Enter key.

5. Press the Tab key until SETUP.PRN file is highlighted. Press the Enter 
key. See Figure 19.

Figure 19

6. Press the Tab key until the OK button is highlighted. Press the Enter 
key.

The parameters contained in the SETUP.PRN file will flash by in the 
window as the file loads. See Figure 20.
24 725-1 Weight Scale, Benchmark 4.1 & 4.2



. .
 . 

. .725 -1  W E IGHT  SCALE

Initial Setup of a Newly Installed Scale
Figure 20

7. Using the keyboard, press and hold the Alt key and the letter M 
(Alt + M). A drop down menu appears.

8. At the drop down menu, use the keyboard down arrow, and scroll 
down the menu until Edit is highlighted. Press the Enter key.

Do not change (Edit) any of the values displayed. The setup file with the 
correct parameters is now loaded.

Attention
If the setup file is not saved, the data will be lost when the weight scale is 
powered up again.

9. Using the keyboard, press the letter S to Save the setup file which 
was just loaded. See Figure 20.

10.Using the keyboard, press F2 to connect to the weight scale.

11.Repeat step 1 through step 10 for each new weight scale installed. 
This is only required during the initial installation.
725-1 Weight Scale, Benchmark 4.1 & 4.2 25
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Scale Calibration
Scale Calibration

Introduction Weight scales already installed in the Xyflex or XyflexPro system should 
be calibrated every six months or when a new scale is installed.

Special Tools The calibration process requires the following:

•  Calibration and Setup disk (Sartorious software, part of Calibration 
Kit)

•  Master weight (50 gram mass) (part of Calibration Kit)

•  Cotton glove (or equivalent) (part of Calibration Kit)

•  DB9 cable (part of Calibration Kit, Xyflex only)

Setup of 
Communication 
Cables (Xyflex only)

1. Open the front drop down door.

2. Slide the computer draw out.

3. Connect the supplied DB9 serial cable to Com 2 at the rear of the com-
puter. See Figure 15.

4. Locate the USB serial hub on the right-hand side panel. Remove the 
(applicable) cable of the newly installed weight scale from the hub or 
scale to be calibrated. Connect the cable to the DB9 serial cable. This 
setup shows the connection for Head 4. See Figure 15.

Software Installation

Attention
The Sartorius program file will not work with Windows NT® Operating 
System, the supplied bootable floppy must be used.

1. Insert the calibration and setup disk (part of Calibration Kit) into the com-
puter. Close NT and Restart the computer. The Sartorious screen appears. 
See Figure 16.

2. Remove the dispense cup from the scale pan. Be sure scale pan is 
clean.

3. Using the keyboard, press F2 to connect to the weight scale. See Fig-
ure 21.
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Scale Calibration
Figure 21

4. Using the keyboard, press the letter Z to Zero out the scale. If a nega-
tive weight is displayed, press the letter R to Restart the scale.

Attention
The 50 gram mass (part of Calibration Kit) is a Class I Standard and must 
never be handled with bare hands. Always wear the supplied cotton glove 
(or equivalent) to maintain accuracy when calibrating the scale.

5. Using a cotton glove (or equivalent), place the 50 gram mass on the 
scale pan. Do not handle the mass with bare hands. See Figure 22.
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Scale Calibration
Figure 22

6. Remove the 50 gram mass and if the display does not read zero, press 
the letter Z to zero the scale prior to calibration.

7. Using the keyboard, press the letter C to start the calibration. To abort 
the calibration at any point, press the letter F for clear function.

A value of CalS - 50.0000 g is displayed. See Figure 23.

Figure 23

Using a cotton glove (or equivalent), place the 50 gram mass back onto the scale 
pan. Do not handle the mass with bare hands. Slide the glass cover over the 
mass.

The display will change and CalS 50.0000 g is displayed. See Figure 24.

50 gram mass
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Scale Calibration
Figure 24

After a delay of approximately 10 seconds the difference in the mass and the 
reference value will be displayed. 

The following example is showing CalD +0.0006 g displayed as the 
difference. See Figure 25.

Figure 25
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Scale Calibration
8. Press the letter C again to finish the calibration.

The display will change to 50000.0 mg (without any CALS or CALD being 
displayed). This value is stored in the scales EEPROM. See Figure 26.

Figure 26

9. Remove the 50 gram mass from the scale pan and rezero if necessary.

10.Place the 50 gram mass onto the scale pan. The scale should repeat to 
within tenths of a milligram.

11.Repeat step 1through step 10 for the remaining three heads 
(Xyflex only).
30 725-1 Weight Scale, Benchmark 4.1 & 4.2



. .
 . 

. .725 -1  W E IGHT  SCALE

Support And Calibration Kits And Spare Parts
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Support And Calibration Kits And Spare Parts

Support Kit A support kit is provided and consists of spare draft Cover shields
• Recommended spare parts, materials and/or lubricants that are required for 

preventive maintenance.

Calibration Kit A weight scale calibration kit is provided which includes

•  A calibration weight
•  Sartorious calibration software

Spare Parts Speedline Camalot provides an “As-Built” document package.
The package includes:

•  This document
•  A set of assembly drawings and schematics (where applicable)
•  Spare parts lists

If you are missing any of the above items, please contact the Speedline Camalot 
Technical Publications department (see below) for replacements.
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Technical Support
Technical Support

Getting Support Speedline Technologies provides a 24 hour customer support line that is available 
365 days a year. Support technicians are available to assist you in operating and 
maintaining the weight scale.
They can also troubleshoot any problems that may occur, assist you in obtaining 
replacement parts, and arrange for training on your Camalot equipment.
To contact customer support, dial 1-800-737-8110 and follow the prompts.

Technical Publications Every effort has been made to provide accurate and up-to-date information 
regarding your weight scale.
You may contact Speedline Technical Publications via E-mail to address any 
errors or discrepancies within this document.
The E-mail address is campubs@speedline.cookson.com
You may also contact us by phone @ 1-978-521-7337
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